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1 Introduction 

The aeration system is the most important equipment of a wastewater plant. 75% of the en-
ergy used for the wastewater treatment is covered by the aeration system. The correct de-
sign of the aeration system and the investing costs usually decide over the operation of the 
aeration system. A real comparison of two systems must cover the operation costs of the 
whole life cycle. 

With AQUA AERO you are able to design the aeration system with the mixers and the pipe-
lines for different chamber geometries. You have the choice of membrane aerators (as tubu-
lar-, disc- or plate aerators) and surface aerators (in the next version of AQUA AERO). Out of 
a database you can choose fitting aggregates for the single calculation steps. 

As important efficiency parameter the oxygen efficiency is provided. With the calculation of 
investment, reinvestment and operating costs the economical calculation of AQUA AERO 
covers the whole life cycle of the aeration. 

We added an important feature to AQUA AERO for all who want to optimize their construc-
tion: You can calculate more than just one project and compare them objectively by one val-
ue.  

And you get a detailed documentation of the calculations and true scaled drawings of the 
equipment.  

 

Shortly combined:  

AQUA AERO is a powerfull tool for an economical and procedual planning of the aera-

tion system for a sludge treatment plant. 
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2 User Hints 

In the following we show some important details for the usage of the guide. 

 

 

Important Text 

Important text is marked with these symbols.Their meanings are: 

 

 Here you will find technical information regarding the way of cal-
culation, for aeration technologies or the economical calculations.  

 

 
Important advice for the use of AQUA AERO or for the technical 
or economical construction 

 

Example Calculation example to show mathematical or engineering correla-
tions. 

 

 

Conventions 

In this documentation we use the following conventions: 

• Controls like control panel, menu title, inputs and so on are printed bold 

• Menu title and inside menu points are printed bold and are connected  
with “ > ”.  

 Example: File > Close 

• Numbers- and currency formatings are taken from Windows presettings. 

 

 

Copyright 

Like the software this documentation underlies a widespread, national and international law 
saved copyright. 
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3 Installation 

Precondition 

AQUA AERO requires a PC with about 50 MB of hard disk space, that is compatible 
with Windows 7,Windows 8 or Windows 10. 
For reports requires a Microsoft Word from version 14 (MS Word 2010). 
  

AQUA AERO is a software working with a graphic user interface using windows features. 
This is why Windows must be installed on your computer prior to running AQUA DESIGNER. 

 

 

Installation 

Downlaod AQUA AERO from our website  bitcontrol.info . After start with setup.exe you 
have the demo version of AQUA AERO. 

 

 

4 Handling 

In this chapter the handling of AQUA AERO is described, beginning by the start of the soft-
ware over the menu and symbol bar up to the flow sheme and the calculation forms. 

4.1 Start and exit AQUA AERO 

After a succeeded installation start AQUA AREO with the icon on your desktop. 

 

Chose File > Exit in the menu bar. AQUA AERO and all open projects will be closed.  

4.2 Control Elements 

Menu Bar 

The menu bar contains the functions File, Side View, Reports, Options, Window and with 
„?“ the help. 

 
Fig. 1: Menu bar 
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Summary of the menu commands: 

Menu Command / Description 

File 

 

New: Opens a new project  

Open: Opens an existing project (*.aero) 

Close: Closes the actual opened project  

Save / Save as: Saves a project with an individual name 
(*.aero) 

Last Projects: Shows a list of max. 4 projects  

Exit: Exit AQUA AERO 
 
 
 

Side View 

 
 

Symbol Bar Show/hit symbol bar  

Status Bar Show/hit status bar at the bottom of the screen 

Reports 

 

Detailberichte: Generates detailed reports in MS Word 
 

Complete Report: Generates the complete report from 
dimensioning up to the project life cycle costs 
 

Drawings: Shows a CAD-Drawing of the aeration 
 

Options 

 

Language: Change language german / english 

General Constants: Access to some parameters, for ex-
ample water temperature or pressure losses  

Data Bank: Change, add and delete aggregates 

Window 

 

With AQUA AERO you can display and calculate more than 
just one project.  
Cascade  

Title Horizontal 

Title Vertical  

Close All: Closes all projects 

Help ? Help: Opens AQUA AERO’s help  
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Info: Infodialog of  AQUA AERO 

 

 

 

 

 

 

Icon Bar 

You reach the following functions by the Icon Bar: 

   Opens a new AQUA AERO Project 

   Opens a saved AQUA AERO project 

   Saves an AQUA AERO project 

   Opens the online help 

 

 

Flow Diagram 

After opening a new project you will see a flow diagram at the left side of the screen. It 
shows the status of your calculation and the next possible calculation step. The flow dia-

gram (block) shows the calculation steps and is always visible while calculating. 

 

Meanings: 

Color Description 

green Calculation step was completed 

yellow Next possible calculation step 

grey Calculation step isn’t possible at the moment 

bold Activated calculation form 
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Fig. 2: Flow diagram 

 

With a click onto a green or yellow block the inside calculation form will open. 

 

 

Calculation Form 

With a click to the block in the flow diagram you open the according form. After calculating 
you finish the form with the button Apply and go to the next calculation form via the flow dia-
gram (yellow).  

 

Color Meaning 

White Input field 

Grey Not editable field 
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Fig. 3: Calculaion Form: Basic Data / Start Values 

4.3 Context sensitive Help 

The online help supports you in working with AQUA AERO.  

You can activate the online help with the “?”. Once you’ve pushed the question mark the help 
will open in a tree structure, where you can find themes quickly.  

 

 
Fig. 4: Context sensitive help 
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In the registry Index important words are sorted alphabetically. 

In the Icon bar of the help function there are some standard functions, which are described 
below:  

 

 
Fig. 5: Icon bar of the help function 

 

With Ausblenden (hide), you remove the block scheme of the help function. 

With Zurück (back) and Vorwärts (next) you skim through the pages of the help, that you 
already used (history). Here the functions were taken over, that you know from the internet. 

With F1 you come from AQUA AERO directly to the corresponding information at the help 
function. 
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5 Project Handling 

New Project 

In the icon bar click the Icon . The flow diagram and the calculation form will open.  

 

Open Project 

To open an existing project, go to File > Open and follow the standard diaolog of windows.  

Under File > Last Projects you’ll find a list of the last four projects. 

 

 
Fig. 6: Last Projects 

 

Save Project 

If you want to save a project, choose File > Save and follow the standard dialog of windows.  

With File > Save as it is possible to save a project additionaly at another position. 

 

Change Project 

If you make modifications in a project, all following steps has to be edited again, also all data 
bank contents has to be collected once again. 

There are two exceptions: 

If you choose an aerator with the same loading, the blower selection will remain. 

The selected aerators will remain even if you make modifications. 

All inputs in the white fields and partly the state of the chex boxes (active/inactive) will re-
main. 

 

 
At modifications in a project, the inputs will remain. Please check, 
whether the data and check box contents are still matching or not. 
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6 Basic Data 

Click on Basic Data / Start Values in the flow sheme and the first calculation form will be 
opened. 

At first insert a project name and the subhead. Both positions are the title in the reports.  

 

 
Fig. 7: Basic Data / Start Values 

6.1 Geometry of the Tanks 

The theoretical basis will be found under  Geometry, page 47. 

 

Select the kind of chamber by the option buttons. 

There are circular chambers, ring chambers, rectangular chambers, oxidation ditches and 
miscellaneous chamber types available. 

The input fields will adapt to the chosen chamber geometry. 
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Fig. 8: Geometry of a Circular Tank 

 

You can choose a number of lines of chambers. All calculation steps – except the mixers and 
aerators – reference on the total volume. In the reports you will find both the data for one line 
and for the total project. 

 

 
Fig. 9: Volume of four plug flow reactors 
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6.2 N- and P- Elimination Processes 

Nutrient Elimination 

The theoretical basis will be found under  Nutrient Elimination, page 47. 

 

The aeration time is depending on the kind and the parameters of the chosen nutrient elimi-
nation process.  

 

 
Fig. 10: Processes of Nutrient-Elimination 

 

The following options are available: 

• Nitrification (without denitrification; tL=24 h * tR/tZ) 

• Separate Stage Denitrification (tL=24 h * tR/tZ) 

• Intermittent Denitrification (tL is calculated) 

• Simultaneous Denitrification  (tL=24 h * tR/tZ) 

 

 

Phosphate Elimination 

The theoretical basis will be found under  Biological Phosphate Elimination, page 50. 

 

The excess sludge production will increase by chemical precipitation, the sludge age will de-
crease. 

By the check box you select, whether a phosphate precipitation should be included. 

With the options button you select the precipitant. 

 

 
Fig. 11: Chemical Phosphate Precipitation 

 

Click on Apply and then go to Oxygen Demand in the flow sheme. 
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7 Oxygen Demand 

The theoretical basis will be found under  Determination of the Oxygen consumption , 
page 51. 

 

In the form Oxygen Demand based on your pre selection for 

• Chamber geometry 

• Elimination processes 

• Water amount and 

• Concentrations or loads 

The oxygen demand OUh and the oxygen supply SOTR for membrane aeration and surface 
aeration will be calculated and displayed. 

 

 

Fig. 12: Calculation of oxygen demand and oxygen supply 

 

7.1 Inflow, Biology, Outflow 

As the first step you have to input all data of the waste water inflow and the outflow require-
ments. 

In the form biology you define: 

• how much nutrient will be incorporated in the biomass (XorgN,BM), 

• the amount of biological eliminated phosphorus (XP,BM + XP,bioP)  

• the security factor for the nitrification respectively the aerobic sludge age.  
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Fig. 13: Input of water amount and concentrations 

 

The oscilation factor for nitrification takes the oscilations in the growth of nitrificians and the 
inflow concentrations in consideration. As standard the check box for the security factor is 
activated and the value will be interpolated based on the DWA-Values.  

If you decide to continue with another factor, deactivate the check box and enter the pre-
ferred value. 

 

 

Fig. 14: Manually selection of the security factor 
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7.2 Loads 

To illustrate the different load cases, four load case calculations are provided, as required in 
M 229-1. 

• Load case1, minimum air requirement 

• Load case 2, maximum air requirement, dimensioning of air requirement  

• Load case 3, medium air requirement 

• Load case 4, prognosis 

 

 

Fig. 15: Load cases 

 

As next select the MLSS in the activated chamber. 

In the following field the maximum denitrification ratio is displayed. If the check box is inacti-
vated, the calculation continous with this automatically calculated value. If you decide to low-
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er the denitrification ratio, activate the check box and enter your suitable value. For the fol-
lowing calculations this value will be taken into account. 

 

 
Fig. 16:  Denitrification ratio, chosen for T = 20°C 

 

7.3 Peak Oxygen Uptake 

The results in the following table will be automatically adapted to your inputs, so you easily 
can test the effect of variations in denitrification ratio, temperature etc. 

In AQUA AERO not only the results – for example the oxygen peak -  will be displayed. By 
showing all intermediate results, beginning with the sludge age, via the nutrient balance to 
the peak factors, the calculations are very transparent.  

 

  
Fig. 17: Peak oxygen uptake OUh  

 

 

 

 

7.4 Required Oxygen Supply 
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With the peak oxygen uptake the required oxygen supply SOTR for both aeration methods is 
the next step.  

The required oxygen supply SOTR for the two different types of aeration is determined and 
compared by the peak oxygen consumption. 

You can still influence the required oxygen concentration by entering your experience value 
for the oxygen supply factor α. The worksheet M 229-1 includes some tips for that. 

Experienced values for the oxygen supply factor α you will also find in the theoretical part, 
see  Oxygen Supply Factor, page 58.  

 

 

Fig. 18: Required  oxygen supply SOTR 

 

After this you decide with what kind of aeration method you continue. 
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8 Design Membrane Aeration 

8.1 Membrane Aeration 

8.1.1 Aerator Design 

Before starting the design and selection of the blowers, the kind of aerators is required. 
There are tube aerators, disc aerators and plate aerators available. 

Click on the symbol for the data bank and select the suitable aerator. With OK you leave the 
aerator data bank. 

 

 
Fig. 19: Selection of aerator 

 

The selected aerator will be displayed with the relevant properties. Deciding for the determi-
nation of the blowers is the specific oxygen yield and the pressure loss of the aerators. Both 
values are provided in the data bank. 

 

 

 

8.1.2 Blower Design 

The theoretical basis will be found under  Blower, page 60. 
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The blowers are designed by the required air volume in operation and the counter pressure 
of the aeration system. The dimensioning is for all chambers. 

The required air volume in operation depends on the suction temperature, the geodetical 
height and the specific oxygen yield. 

The counter pressure is the sum of water level, pipeline losses and the pressure loss of the 
aerator. The pressure loss of the pipelines can be edited in Options > Generel Constants. 
The standard value is 100 mbar. 

 

 
If there are modifications in the Generel Constants, you have to 
start the project from the beginning. 

 

 

Fig. 20: Parameter for the design of blowers 

 

8.1.3 Blower Selection 

First choose the number of blowers. Then click the icon  to choose the aggregate. 

The data bank will open and show the first blower in blue that fullfills the requirements. The 
blowers are sorted by the counter pressure in the data base. 

It is possible to sort by any other column, if you click on the header. 
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Fig. 21: Selection of blowers 

 

The colors mean: 

Color Meaning 

red Construction terms are not fullfilled – The blower counter 
pressure or the air transfer are too small. 

blue Mark 

yellow Construction terms are fullfilled 

 

Mark the blower and hit OK. The data bank closes and you get back to the calculation form.  

 

The following data will be displayed in the blower frame: 

• Manufacturer, Type 

• Motor power and coupling power of the blower 

• Air volume of each blower and the total air volume of the type 

• The relation of blower air supply and the required air volume 

• The counter pressure for the selected blower 

The coupling power and the air volume will be interpolated for the operation point. 

 

 Evaluation of the operation point 

In the data bank for every blower type the motor power is present for the 
required counter pressure. 

This means, every blower is listed in the data bank for several times for 
different pairs of counter pressure and motor power. 

All operation points between will be interpolated. 

 

If you like to select more blowers, click on the button  at the lower border of the form. A 
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further frame for the blower selection will occure. The check box Blower Design is activated. 

 

 Blower selection / stepping 

For a good design its recommend to proofe how the loading will be during 
the life time of the equipment. If there will be a phase of low capacity load-
ing, for example at the beginning of operation of the plant or during the 
seasons (touristic, wine) its convenient to have blowers of different capaci-
ties, so that you have matching blowers for all loading conditions. 

At normal loading conditions it depends on the denitrification process, the 
activated sludge process and the size of the plant, how much the air de-
mand is varying. 

Separate stage denitrification 

If there is a contineous aeration, the aeration will commenly be controlled 
via the reference value. The air demand is then oscilating like the inflow 
load. For this case its recommended to step the blowers. 

Intermittent denitrification 

Here the oxygen demand is compressed to the aeration time. The oscila-
tion of the demand is not as significant as in the separate stage denitrifica-
tion. Especially for small and middle size plants two blowers of the same 
size are suitable for most of the times. 

 

8.1.4 Blower Graduation 

Blower graduation is usefull to adapt the aeration capacity to different load conditions, for 
example when you have low loads at the beginning of the operation of the plant or for the low 
loads in the night. 

Click the check box Blower Graduation and input the wanted steps – in our example 25, 50 
and 100%.  

 

 
Fig. 22:  Blower graduation 

 

At the frame of the blower selection click the icon . In the data base there is an automatic 
filter for the chosen steps.  

 

For example click 50% so all blowers will be marked light blue, that apply to these criteria. 
Mark a blower and click OK. The data base closes. 

If you now for example want to add two blowers with 25% click onto the icon  and input the 
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number of blowers. Take care that the check box of the aeration control is activated. Open 
the data base and click 25% and choose a suitable beige marked blower. 

To check witch part is covered by the blower, click Apply. In the calculation form the value is 
displayed in %. Click OK, to exit the data bank. 

 

 
Fig. 23: Filter for blower graduation (here: 50%) 

8.1.5 Standby Blower 

If you want to choose a standby unit click the icon   at the bottom frame of the calculation 
form. A further frame appears to choose a blower.  
Deactivate the check box Blower Design.  

Then choose the blower out of the data base like shown at the top. 

At the bottom Air Volume,total is displayed. The standby blower will not be included in this 
value. 

 

 
Fig. 24: Selection of a standby blower 

 

The standby aggregates are not integrated into the dimensioning of the blowers and pipe-
lines. They won’t be part of the operating costs, but they will be contained in the investment 
costs. 
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8.1.6 Remove Blower 

If you notice that you don’t need a blower click the check box Remove and push the icon . 
If you only want to delete the last blower click . 

 

 
Fig. 25: Remove blower 

 

8.2 Mixer 

Design Mixer 

Choose Mixer in the flow diagram. A calculation form opens to design and select the mixer. 

 

 
Fig. 26: Design and selection of a mixer 

Basic parameter for the construction of the mixer is the required power densitiy, which is pre-
set with 2,5 W/m³. 

 

Selection Mixer 

 
The selection of mixers applies for one chamber. 

 

After inputting the power density (standard value), you input the number of mixers and 
choose them from the data base. The mixers that match the nominal value are marked yel-
low. Mark a fitting mixer and click OK.  

The following informations will be showed: 
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• Make / Type 

• Motor power of the mixer 

• Diameter and  

• Power densitiy 

• Number of mixer for all tanks. 

No Mixer 

Off course you don’t have to choose a mixer, if the mixing for example with aeration shots is 
approached. This has the advantage that the investing costs and the operating costs could 
be less at specific conditions. Input the number 0 and go on over the flow diagram. 

 

8.3 Aerator 

8.3.1 Kind of Aerator 

The kind of aerator you already have chosen in the form Membrane Aeration, because we 
need the data of the aerator for dimensioning of the blowers. 

 

 Tube aerators: 

With tube aerators the data base shows the length of the aerators. 

 
 

Plate and disc aerators: 

For the plate and disc aerators the figure for the true scaled drawing its sup-
posed that the disc are central placed on the distribution pipes. 
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8.3.2 Construction 

 
The construction of the aeration equipment is for one chamber. 

 

The theoretical basis will be found under  Aerator, page 60. 

 

Depending on the chamber geometry and the kind of aerator you are able to arrange the 
aeration equipment by several parameters and options. 

You can vary: 

• The load of the aerator (it should be not higher than the max. value, given in the data 
bank) 

• Number of grits 

• Number of distributors 

• Arrangement of the aerators 

• Distances wall, aerator, grid, mixer 

 

For the option Other Forms of the tank there is no possibility of constructing the equipment. 
By the aerator load you are only able to change the number of aerators. 

All changes will be actualized directly, so you can simply and fast adapt the construction to 
the given situation. 

The construction will be displayed in a true scaled drawing in a CAD-tool. You are able to 
zoom and move the drawing and export it in standard formats like dxf. 

Some examples: 

 

 
Fig. 27: Tube aerators in plug flow reactor 
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Fig. 28: Tube aerator in rectangular tank, aeration on one side 

 

 
Fig. 29: Disc aerators in circular tank 
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8.4 Pipelines 

The theoretical basis will be found under  , page 61. 

 

Click Pipelines in the flow diagram so the calculation form for the construction of the pipe-
lines will open.  

 

 
Fig. 30:  Dimensioning of pipelines 

 

In the top frame the pre selections are displayed. Under the assumption of adiabatic com-
pression the compressed air volume is calculated out of the suction volume. 

Now, finally select the velocity in m/s. 

 A velocity of air between 12 – 18 m/s is recommended. 

 

In the frame Pipeline – Selection for all Tanks you get a listing of all pipes for the chosen 
chambers and blowers.  

 

 
Fig. 31: Pipelines 
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For information about the various diameters click .  A drawing with the name of the pipe-
line will be displayed. 

 

 
Fig. 32: Labeling of pipelines 

 

It is valid for all pipes: 

The connecting pipelines are designed for the compressed air volume of the appropriate 
blower. 

All other pipes are dimensioned for the total volume of all blowers, considered for the aerator 
dimensioning. The total volume is divided by the number of pipes. 

 

Example Chosen: Displayed: 

 Two blower GM 35S 

 

Connecting pipe (1) for blower GM 35S  

For the invest costs two connecting pipes for 
the two blowers will be taken into account.  

 One standby GM 80L 

 

Connecting pipe (1) for GM 80L  

 Two oxidation ditches 

 

Inflow pipe (3) to the two chambers; the com-
pressed air volume will be divided to the two 
chambers. 

For the invest costs, the two inflow pipes will 
be taken into account. 

 

Finally select the pipeline diameter DN for the different pipes and confirm with Apply. 

In the frame Free Calculation you have the possibility, to convert the air volume to the di-
ameter quickly for any desired volume. It is only a little tool. The calculation doesn’t affect the 
other measurements. 
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Fig. 33: Free calculation 

 

With the construction of the pipelines the design of the aeration system is finished. In the flow 
diagram you can notice this by the blue connections of the blocks. 

 

 
Fig. 34: Finished design of membrane aeration 

 

Further and following tools are the oxygen efficiency, invest- and operational costs and the 
life cycle costs. 

 

9 Oxygen Efficiency 

The theoretical basics will be found under  Oxygen Efficiency, page 65. 

 

The oxygen efficiency is the key figure for the economy of an aeration system. It shows how 
much energy is needed to charge the required oxygen. 



BITControl 
AQUA AERO 3.x - manual Seite: 32 von 82 

10 Investment Costs Version: 3.0-02  
 

 

 

For the calculation of the oxygen efficiency the power consumption of blowers and mixers is 
required. 

First enter the mechanical losses and the losses of the frequency converter, if given. With 
these losses, the efficiency of the motor and the coupling power of each blower, the total 
power consumption is calculated. 

The real power consumption of the mixers depends on several factors. Its recommended to 
request this from a supplier. The motor power is preselected by AQUA AERO. 

 

 
Fig. 35: Calculation of the oxygen efficiency 

 

Yor are able to input a specific oxygen yield for operation, independent from the design 
value. This value will be taken into account for the calculation of the oxygen efficiency. 

 

For the specific standard oxygen transfer efficiency SSOTE applies: 

Design: For the peak demand 

Operation: For the average demand (usually a better value) 

 

As result you get the hourly oxygen input SOTR and the oxygen efficiency for the blowers 
and for the sum of blowers and mixers. 

10 Investment Costs 

The theory for the calculation of invest costs will be found under  Investment Costs,  
page 67. 

 

In the calculation of the investment costs the following positions are included: 
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• Planning costs 

• Costs for construction of blower room (Construction I) 

• Costs for excavation (Construction II) 

• Mechanical equipment and pipelines 

• Electrical equipment 

• Measuring equipment 

 

Additional to the parameters for the invest, also the life time of each component is requested 
here. So all informations for each component can be entered at one place. The life time has 
no effect to the invest costs, but for the calculation of the reinvest. 

10.1 Consulting and Construction 

Consulting costs are considered as lump-sum. 

For the blower room length, width and height are calculated with the number and size of the 
chosen blowers. Nevertheless you enter your own size values. With the orientation price, the 
construction costs are calculated. 

Also excavation can be edited. 

 

 
Fig. 36: Costs for consulting and constructing 

 

 

 

10.2 Mechanical Equipment 

In the frame Mechanical Equipment all aggregates resulting from the way of design will be 
displayed. Furthermore the required pipelines are contained.  

The following inputs are necessary: 

• Material and length of the different pipes (length of distribution pipe and falling pipe are 
preselected) 

• Number and kind of valves 



BITControl 
AQUA AERO 3.x - manual Seite: 34 von 82 

10 Investment Costs Version: 3.0-02  
 

 

• Sound box yes/no 

• Selection of a data set of the aeration grid 

• Number of lift devices for the aerator equipment (preselected is the number of chambers) 

• Unit price for all positions (prices are partly provided by the data banks) 

• Life time for all positions (an experienced life time is presetted) 

 

 
Fig. 37: Costs for mechanical equipment and pipelines 

 

 

 The life time is used for the calculation of the reinvest costs. Its 
not considered by the invest costs. 

 

10.3 Electrical and Measuring Equipment 

For electrical and measuring equipment you enter lump sums and life time. 

 

 



BITControl 
AQUA AERO 3.x - manual Seite: 35 von 82 

11 Operating Costs Version: 3.0-02  
 

 

Fig. 38: Costs for electrical and measering equipment 

10.4 Result 

The complete invest costs for the aeration system with consulting, construction, mechanical, 
electrical and measuring equipment will be displayed at the bottom of the form. Therefore 
move the scroll bar to the bottom. 

 

 
Fig. 39: Result of invest costs 

 

Click on Apply and select the next Step in the flow sheme. 

11 Operating Costs 

The theory for the calculation of the operational costs will be found under  Operating Costs, 
page 68 

Click the block Operation Costs. A calculation form opens, where the operating costs are 
detected: 

• Energy costs blower 

• Energy costs mixer  

• Costs for ressources 

• Maintenance 

 

 

Energy Costs 

Enter the energy price of the provider in the frame Basic Data. 

The factor average O2-demand means the difference between the design oxygen demand 
and the average demand in operation. The preselected value is matching to the common 
conditions. 

If only a part of all mixers are designated to be in operation in the aeration phase, you can 
enter this in Number, in aerated phase. 
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Fig. 40: Energy costs 

 

 

 

 

Other Operating Costs 

Activate the check box Miscellanous for further components of the operation costs. 

 

 
Fig. 41: Other operating costs and result 

 

 

Result 

Finally click Apply and the operating costs will be displayed in the bottom part of the form. 
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12 Project Life Cycle Costs 

The theory will be found under  Project Life Cycle Costs , page 71. 

 

With the Project Life Cycle Costs two aeration systems with different investment and oper-
ating costs can be compared. For this the coming costs will be calculated to the point of start-
ing the operation (year = 0).  

 

 
Fig. 42: Project life cycle costs 

 

The first value is the life time of the project. Commonly this is 25 years for aeration mechani-
cal equipment. In the literature for the evaluation of the oeconomic of replacing an existing 
system a life time of 10 years is recommended. 

 

 
Fig. 43: Project life time, interest and increase rate 

 

In the frame the invests are displayed. Here all invest components are sorted and sampled 
by the life time into packages Mechanical Equipment 1…, 
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Fig. 44: Invest and nominal reinvest 

 

If you click on the button left to the packages, the groups will be extended and you see the 
contained components. 

 

 
Fig. 45: Reinvest "opened" 

 

In the bottom part of the form you get the result of the cost calculation: 

• Nominal costs for invest, reinvest and operation 

• Current value for invest, reinvest, operation are discounted to the zero point, incl. the inter-
est rate for operating cost 

• Project Life Cycle Cost as sum of the current value 

 

 
Fig. 46: Result: nominal and current values 
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You now have the complete calculation from the construction of the aeration system to the 
detection of the oxygen efficiency, investment and operating costs to the project life cycle 
costs.  

 

 
Fig. 47: Completed project 

13 Reports 

For every step of calculation a detailed report is generated, with all intermediate results, for-
mulas and the ways of calculation. 

 

Its possible to generate the following reports in MS Word:  

• Dimensioning 

• Pipeline 

• Oxygen efficiency 
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• Invest costs 

• Operation costs 

• Project life cycle costs 

• Complete report 

 

To generate the reports, it is first necessary to complete the according calculation. The data 
will be confirmed by clicking Apply. Then the section in the flow sheet is marked green. 

Only for the report Design its possible to generate intermediate reports. The report will be 
generated up to the steps which are completely finished. For example, if you only need to 
calculate the oxygen demand, it is not necessary to go through the following steps Mem-

brane Aeration and Mixer. 

If you have finished a complete project from Basic Data to the Project Life Cycle Costs, 
there is a Complete Report containing  all results and sections. 

To generate a report goto Menu > Reports and select a detailed report or the Complete 

Report. 

 

 
Fig. 48: Reports 

 

MS Word will open and a detailed Report will be generated. On the first page you will find the 
project data. Now the report is completely available in Word for further handling. 
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Fig. 49: Report with detailed data and true scaled drawing 
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14 Drawing 

You can generate a CAD-Drawing of the aeration construction. Click on the drawing and the 
CAD-tool will start. Now further functions are available. 

 

 
Fig. 50: CAD-drawing 

 

You can save the file for later editing or handling. Chose File  > AERO CAD Save As. With 
the menu Documentation > Drawings you can open the Drawing modul and the chosen 
field. 

If you want to save the drawing in another format choose File > Export and the required 
format. 

Formats available: 

• DXF 

• Bitmap 

• GIF 

• Metafile 

• PNG 

 

You leave the CAD-Modus with File > Exit. 
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15 Define Constants 

Several constants as basis for the calculations are available and editable under Options > 

General Constants. 

 

 
Fig. 51: General constants 

 

The following constants could be defined: 

• Wall thickness of the chambers 

• Height of Aeration over the bottom  

• Pressure loss of the pipelines. 

 

The thickness of walls is necessary for the true scaled drawings. 

The construction height of the aerators is needed to calculate the counter pressure by the 
water level. 

The pressure loss of the pipelines is also needed for the counter pressure of the blowers. 

 

 
If a general constant will be changed this affects on the total way 
of calculation. Therefore for all running projects AQUA AERO 
goes back to the form Basic Data if you change a general con-
stant. Input values and selected data sets will mostly remain. 

 

Adapt the values to your demand and press OK. 

Because the design basis will be changed by editing a general constant, all projects will be 
reseted to the basic parameters. 
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Fig. 52: Attention request 

 

Affirm with Yes and store the input with OK. Restart the design with the Basic Data. 
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16 Data Bank 

In AQUA AERO all equipment with their descriptions and parameters are saved in one data 
base.  

The data bank contains common brands. The user can add own data or edit the present da-
ta. At a later update the earlier files of course will be optained. 

 

For each component an own table is created which you can reach over Options > Data 

Bank. 

 

 
Fig. 53: Options > Data Bank 

 

The chosen table out of the data bank opens.  

With the icons on top of the form you can add, edit and delete aggregates. 

 

 
Fig. 54: Table blower 
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To add new data click this icon , at the right of the icon bar. A dialog opens where you 
can for example input parameters of a new blower. With OK the new data will be saved and 
you will get back to the table. 

 

 
Fig. 55: Add blower 

 

To edit a data set mark it and click the icon   in the middle of the icon bar. A dialog opens 
where you can edit files. 

 

To delete a data set mark it and click the icon  .  A safety question appears that you 
should answer with yes.  

 

Finally click Close in the table to leave the data bank. 

17 Theory 

17.1 Introduction 

In the following chapters the theoretical basics for AQUA AERO are described. 

Part of this is the design of the aeration system with evaluation of the oxygen demand and 
the oxygen supply, the transfer from clean water conditions to waste water conditions and 
the adaption to local conditions. 

As an important value for the efficiency of an aeration system the way of calculation for the 
oxygen efficiency is described. 

The third parts includes oeconomical calculations as invest-, operation- and reinvest costs 
and as a conclusion the project life cycle costs. 
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17.2 Basic Data 

The main parameters for the design of the aeration system are the load, the chamber geom-
etry and the chosen elimination processes. 

17.2.1 Geometry 

There are four standard types of chambers available. 

The volume of the chamber results from the geometry. 

 

Round tank 
[ ]³²*

4
** mDhnV ATWATAT

π
=  

Circular tank 
 [ ]³²)²(*

4
**

,
mDDhnV

iATATWATAT −=
π  

Rectangular tank 
 

[ ]³***
2,1,

mLLhnV ATATWATAT =  

Plug flow reactor 
 

[ ]³²*
4

*** mDDLhnV ATATATWATAT 







+=

π
 

Other chamber types 
 

editVAT  

International: German:  
DAT Outer free diameter of the activated 

chamber 
DBB Äußerer lichter Durchmesser des 

Belebungsbeckens 
m 

DAT,i Inner Diameter of a ring chamber DBB,i Innendurchmesser beim  
Ringbecken 

m 

hW Water level hw Höhe des Wasserspiegels m 
LAT Length of the aeration tank LBB Länge Belebungsbecken m 
nAT Number of tanks nBB Beckenanzahl - 
VAT Volume of the aeration tank VBB Volumen des Belebungsbeckens m³ 

17.2.2 Elimination Processes 

General 

Four variants for the nutrient elimination and three processes for phosphate elimination are 
available.  

Nutrient Elimination 

Only Nitrification 

After the conversion of organical bounded nutrient into ammonia, the ammonia will be oxi-
dated into nitrate by the two steps of nitrification. Therefore oxygen is required by nitrosomo-
nas and nitrobacter. 

 

2 NH4
+ + 3 O2     �     2 NO2

-  + 2 H2O + 4 H+ 

2 NO2
- + O2     �     2 NO3

- 



BITControl 
AQUA AERO 3.x - manual Seite: 48 von 82 

17 Theory Version: 3.0-02  
 

 

 

This process can only take part, if the retention time is sufficient for the nitrificants. This 
means the aerobic sludge age has to be high enough, see  Sludge Age, page 51.  

 

If the option nitrification is selected, denitrification will not take part. 

The aeration time for the design: 

 htL 24=  

 

 

Nitrification / Denitrification 

At the denitrification process the solved nitrate (and nitrite) will be reduced to elementar nu-
trient N2 at absence of oxygen. By this process oxygen is reused by the bacteria. Nutrient 
disappears as gas into the atmosphere. 

Equation for Denitrification: 

2 NO3
-+ 2 H+       �      N2 + H2O + 2,5 O2 

 

If you choose a denitrification process, this means:  

• As first step you need the nitrification, so the aerobic sludge age has to be verified. 

• For intermittent denitrification the aeration time will be calculated, for all other process the 
aeration time is 24 h/d. 

 

Depending on the denitrification process the denitrification ratio is: 

 

SS

aerobSS

AT

D

t

t

V

V ,
1max −=  

 

International: German:  

tSS Sludge age, cell residence time tTS Schlammalter d 

tSS,aerob Aerobic sludge age tTS,aerob Aerobes Schlammalter d 

VAT Volume of the aeration tank VBB Volumen des Belebungsbeckens m³ 

VD Volume of the biological reactor 

used for denitrification 

VD Für Denitrifikation genutztes 

Volumen des Belebungsbeckens 

m³ 

 

 

Separate Stage Denitrification 

At separate stage denitrification the two steps nitrification and denitrification take part in dif-
ferent tanks. The denitrification part will only be mixed and the nitrification part will be aerated 
24 h/d. 
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Fig. 56: Flow diagram of separate stage denitrification 

 

The aeration time is: 

 htL 24=  

 

 

Simultaneous Denitrification 

At simultaneous denitrification the wastewater passes aerated and anoxic zones in one 
chamber, for example an oxidation ditch. 

The aeration time will be: 

 htL 24=  

 

It is difficult to control this process and to define the recirculation ratio exactly. Oxidation ditch 
and ring chamber are matching to this process. 

 

 

Intermittent Denitrification 

At the intermittent denitrification the oxidation of ammonia to nitrate and the reduction of 
nitrate to N2 will be reached by a change of aerated and unaerated times in a chamber. 

The aeration time is similar to the denitrification ratio: 

 [ ]hh
V

V
tL

AT

D 24*1 







−=  

 

Because the aeration of the oxygen input does not proceed for 24 hours, but only during the 
aeration time, the aeration system has to be larger than for the other processes. 

The advantage of the intermittent denitrification is the good control ability and the high 
theoretical recirculation rate and so the high denitrication rate. 
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Biological Phosphate Elimination 

Bacterias use the phosphate for the energy catabolîsm and anabolism. Furthermore there 
are bacteria which use phosphate for energy storage. This is named as biological precipita-
tion. 

The total amount of biological phosphate elimination will be requested by AQUA AERO. It will 
be divided into the part for metabolism (XP,BM) and for extended biological elimination 
(XP,bioP). 

 







=+=

kgBSB

kgP
BMPwithbioPPBMP 0015,0,max,,totbioP,  

 


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l
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CBMP IATBODBMP ,, *,X  

 





=

l

mg
CbioPP IATBODP ,bioP, *,X  

Chemical Phosphate Elimination 

Additional to the biological elimination the chemical precipitation can be chosen. Aluminium 
and iron precipitants are available. The chemical precipitation rate depends on the further 
biological elimination. 

The part of chemical phosphate precipitation result on a phosphate balance: 

 

 





=

l

mg
BioPP,BMP,ESTP,IATP,PrecP, X -X-C-CX  

 

International: German:  

CBOD,IAT Concentration of BOD5 in the 

homogenised sample, Influent 

activated tank 

CBSB,ZB BSB5-Konzentration im Zulauf zum 

Belebungsbecken 

mg/l  

CP,EST Concentration of phosphorus, 

effluent sedimentation tank 

CP,NB,Z Phosphor Konzentration im Ablauf 

Nachklärung 

mg/l  

CP,IAT Concentration of phosphorus, 

inflow aeration tank 

CP,BB,Z Phosphor Konzentration im Zulauf 

Belebungsbecken 

mg/l  

Pbio,P Total bio phosphate, referred to 

BOD5 

Pbio,P Gesamtes Bio-Phosphat, bezogen 

auf den BSB5 

kg 

P/kg 

BSB5 

XP,BioP Concentration of phosphorus 

removed with biological excess 

phosphorus removal process 

XP,Prec Bei der biologischen P-Elimination 

biologisch gebundener Phosphor 

mg/l 

XP,BM Concentration of phosphorus 

embedded in the biomass 

XP,BM In die Biomasse eingebauter Phos-

phor (Zellaufbau) 

mg/l 

XP,Prec Concentration of phosphorus 

removed by simultaneous precipi-

tation 

XP,Fäll Durch Fällung eliminierter Phosphor mg/l 

P,BM Phosphate for celle design, re-

ferred to BOD5 

P,BM Phosphat für Zellaufbau, bezogen 

auf den BSB5 

kg 

P/kg 
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BSB5 

 

Both the biological and the chemical phosphate elimination increase the excess sludge pro-
duction and affect the retention time of the activated sludge in the activated chamber respec-
tively the sludge age. 

17.3 Determination of the Oxygen consumption  

17.3.1 General 

 The calculation methods for the design of the aeration equipment are mainly based on the 
ATV-A 131 /2/. 

 

In AQUA AERO the following steps are calculated: 

• Determination of the sludge age 

• Daily oxygen demand for C- and N-Elimination 

• Hourly peak-oxygen uptake under consideration of peak factors. 

 

Therefore, the temperature and pressure dependence of biological and physical processes 
are taken into consideration in the aeration tank. 

17.3.2 Sludge Age 

The oxygen uptake for the C-Elimination depends on the total sludge age (tSS). The slude 
age is a parameter for the retention time of the sludge in the activated system. 

For stable nitrification processes the aerobic sludge age has to be ensured.  

If the total sludge age is lower than the required aerobic sludge age, the retention time is not 
sufficient to establish the nitrificants in the system. Then in AQUA AERO the oxygen demand 
is zero for nitrification.  

 

Aerobic Sludge Age 

For nitrification the minimum aerobic sludge age is required. 

 [ ]dSFt
T

aerobSS

)15(

dim,, 103,1*4,3
−∗=  

The security factor depends on the variation factors fC, fN and the cleaning requirements. 

Municipal WWTP:  
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 It is linearly interpolated between these values. 

 

International: German:  
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Bd,BOD Daily BOD5-load Bd,BSB5 Tägliche BSB5-Fracht kg/d 

SF Safety factor for nitrification SF Sicherheitsfaktor für Nitrifikation - 

T Temperature T Abwassertemperatur °C 

tSS,aerob Aerobic sludge age tTS,aerob Aerobes Schlammalter d 

 

The security factor considers variations in the growth rate of the nitrificants and in the con-
centrations in the feed and in the effluent. /2/. 

 

 

Total Sludge Age 

The total sludge age is iterated for three temperature conditions.  

The following formulas are used: 
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International: German:  

Bd,BOD Daily BOD5-load Bd,BSB5 Tägliche BSB5-Fracht kg/d 

CBOD,IAT Concentration of BOD5 in the 

homogenised sample; Influent 

activated tank 

CBSB,ZB BSB5-Konzentration im Zulauf zum 

Belebungsbecken 

mg/l  

FT Temperature factor for endoge-

nous respiration  

FT Temperaturfaktor für endogene 

Veratmung 

- 

SPd Daily waste activated sludge 

production (solids) 

ÜSd Tägliche Schlammproduktion kg/d 

SPd,P Daily sludge production from 

phosphorus removal 

ÜSd,P Tägliche Schlammproduktion aus 

der Phosphorelimination 

kg/d 

SSAT Mixed liqour suspended solids in 

the activated tank (MLSS) 

TSBB Trockensubstanzgehalt im  

Belebungsbecken 

kg/m3 

tSS Sludge age, cell residence time tTS Schlammalter d 

XP,BM Concentration of phosphorus 

embedded in the biomass 

XP,BM In die Biomasse eingebauter Phos-

phor 

mg/l 

XP,Prec Concentration of phosphorus 

removed by simultaneous precipi-

tation 

XP,Fäll Durch Fällung eliminierter Phosphor mg/l 

XSS  Concentration of suspended solids 

of wastewater; Influent activated 

XTS, ZB Trockensubstanzkonzentration im 

Zulauf zum Belebungsbecken 

mg/l 
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tank 

 

The excess sludge production for biological and chemical phosphate elimination SP,d,P will be 
taken in consideration. 
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At precipitation with FeCl3, XP,Prec,Al = 0, at precipiation with AlCl3, XP,Prec,Fe=0  

 

International: German:  

CBOD,IAT Concentration of BOD5 in the 

homogenised sample, Influent 

activated tank 

CBSB,ZB BSB5-Konzentration im Zulauf zum 

Belebungsbecken 

mg/l  

CP,EST Concentration of phosphorus, 

effluent sedimentation tank 

CP,NB,Z Phosphor Konzentration im Ablauf 

Nachklärung 

mg/l  

CP,IAT Concentration of phosphorus, 

inflow aeration tank 

CP,BB,Z Phosphor Konzentration im Zulauf 

Belebungsbecken 

mg/l  

Pbio,t Total bio phosphate, referred to 

BOD5 

Pbio,t Gesamtes Bio-Phosphat, bezogen 

auf den BSB5 

kg P/kg 

BSB5 

Qd,DW Inflow at dry weather per day Qt,d täglicher Trockenwetterzufluß m³/d 

SPd,P Daily sludge production from 

phosphorus removal 

ÜSd,P Tägliche Schlammproduktion aus 

der Phosphorelimination 

kg/d 

XP,BioP Concentration of phosphorus 

removed with biological excess 

phosphorus removal process 

XP,Prec Bei der biologischen P-Elimination 

biologisch gebundener Phosphor 

mg/l 

XP,BM Concentration of phosphorus 

embedded in the biomass 

XP,BM In die Biomasse eingebauter Phos-

phor (Zellaufbau) 

mg/l 

XP,Prec Concentration of phosphorus 

removed by simultaneous precipi-

tation 

XP,Fäll Durch Fällung eliminierter Phosphor mg/l 

17.3.3 Oxygen Uptake 

The oxygen uptake in the activated chamber results from the demand for C-degradation, 
nitrification and the reuse of oxygen because of the denitrification. 
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 If nitrification is chosen (without denitrification) OUd,D (OVd,D) = 0. 

 If the total sludge age is smaller than the aerobic sludge age then  OUd,N (OVd,N) = 0. 

 

The oxygen uptake for the C-elimination OUd,C depends on the temperature. This will be 
considered both for the sludge age and the temperature factors. 

 

The oxygen uptake of the N-elimination results from the nutrient balance. 
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The following points have to be considered: 

• For the balance the nitrate outflow concentration is set to 0 mg/l. 

• SNO3,D is the minimum from the denitrificable and the nitrate to be denitrificated. 

 

International: German:  

Bd,BOD Daily BOD5-load Bd,BSB5 Tägliche BSB5-Fracht kg/d 

FT Temperature factor for endogenous 

respiration  

FT Temperaturfaktor für endogene 

Veratmung 

- 

OUd,C Daily oxygen uptake for carbon removal OVd,C Täglicher Sauerstoffverbrauch für die 

C-Elimination 

kg/d 

OUd,D Daily oxygen uptake for carbon removal, 

which is covered by denitrification 

OVd,D Täglicher Sauerstoffverbrauch für die 

C-Elimination, der durch die Denitrifi-

kation gedeckt wird 

kg/d 

OUd,N Daily oxygen uptake for nitrifikation OVd,N Täglicher Sauerstoffverbrauch für 

Nitrifikation 

kg/d 

Qd,DW Daily wastewater inflow with dry weather Qd Täglicher Abwasserzufluss bei Tro-

ckenwetter 

m³/d 

SNH4,EST Concentration of ammonium nitrogen, 

effluent of sec. settling tank 

SNH4,AN Ammonium Stickstoff, Ablauf Nach-

klärbecken 

mg/l 

SNO3,D Concentration of nitrate nitrogen to be 

denitrified 

SNO3,D Zu denitrifierender Nitratstickstoff mg/l 

SNO3,denitrificable Concentration of denitrificable nitrate 

nitrogen  

SNO3,denitrifizierbar Konzentration des denitrifizierbaren 

Nitratstickstoffs  

mg/l 

SNO3,EST Concentration of nitrate nitrogen, effluent 

of sec. settling tank 

SNO3,D,AN Nitratstickstoff, Ablauf Nachklärbe-

cken 

mg/l 

SNO3,IAT Concentration of nitrate nitrogen, influent 

of activated tank 

SNO3,ZB Nitratstickstoff, Zulauf Belebungsbe-

cken 

mg/l 

SorgN,EST Concentration of nitrate nitrogen, effluent 

of sec. settling tank 

SorgN,AN Nitratstickstoff, Ablauf Nachklärbe-

cken 

mg/l 
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tSS Sludge age, cell residence time tTS Schlammalter d 

VAT Volume of the aeration tank VBB Volumen des Belebungsbeckens m³ 

VD Volume of the biological reactor used for 

denitrification 

VD Für Denitrifikation genutztes Volumen 

des Belebungsbeckens 

m³ 

XorgN,BM Concentration of organic nitrogen em-

bedded in the biomass 

XorgN,AN In die Biomasse eingebauter organi-

scher Stickstoff 

mg/l 

 

The real nitrate outflow value is the difference between the nitrate denitrificable and the ni-
trate to be denitrificated. If the first one is higher then SNO3,EST = 0 mg/l 

17.3.4 Peak Oxygen Uptake 

For the dimensioning of the aeration, the peak oxygen uptake per hour is decisive. This will 
be taken into consideration at the conversion from daily to hourly O2-uptake with the peak 
factors. 
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International: German:  

fC Peak factor for carbon respiration fC Stoßfaktor für die Kohlenstoffatmung - 

fN Peak factor for ammonium respiration fN Stoßfaktor für die Ammoniumoxidation - 

OUd,C Daily oxygen uptake for carbon removal OVd,C Täglicher Sauerstoffverbrauch für die C-

Elimination 

kg/d 

OUd,D Daily oxygen uptake for carbon removal, 

which is covered by denitrification 

OVd,D Täglicher Sauerstoffverbrauch für die C-

Elimination, der durch die Denitrifikation 

gedeckt wird 

kg/d 

OUd,N Daily oxygen uptake for nitrifikation OVd,N Täglicher Sauerstoffverbrauch für Nitrifi-

kation 

kg/d 

OUh Oxygen uptake rate (hourly) OVh Stündlicher Sauerstoffverbrauch kg/h 

 

The peak factors fN and fC are linear interpolated (in two directions) with the following table. 

 

 

 

tSS [d] 4 6 8 10 15 25 

fC 1,3 1,25 1,2 1,2 1,15 1,1 

fN (BdBOD<=1200)    2,5(*) 2,5 2 1,5 

fN (BdBOD>6000   2 1,8 1,5 1,5 

Table 1: from table 8, DWA-A131/2/ 

(*) the value has been set for the interpolation between 8 and 10 days and BdBOD between 1200 and 6000 

 

Different load cases for N and C-peaks are calculated because both peaks usually don’t oc-
cure at the same time. For the middle load fN and fC are set to 1. 

At separate stage, intermittent and simultaneous denitrification 8 load cases have to be veri-
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fied. 6 load cases for denitrification and 2 for nitrification for low temperature conditions. 

If only nitrification is required, only 6 load cases for nitrification have to be verified. 

 

 Nitrification Nitrification /  
Denitrification 

 

Load case  
winter 

fC and fN = 1 
fC = 1 and fN 

fC and fN = 1 
fC = 1 and fN 

In middle europe commonly the winter 
temperature is assumed to  10°C. 

Load case  
design tem-
perature 

fC and fN = 1 
fC = 1 and fN 

fC and fN = 1 
fC = 1 and fN 

Recommended: 12°C. 

Load case 
highest tem-
perature 

fC and fN = 1 
fC = 1 and fN 

fC and fN = 1 
fC = 1 and fN 

usually 20°C.  
Because of the lower solubility of oxy-
gen in water at high temperature this 
usually is the most unfavourable case 
for the aeration. 

Table 2: Load cases for intermittent denitrification 

 

After the evaluation of the peak oxygen uptake the further way of calculation is different for 
pressure and surface aeration. 

For pressure aeration you can continue here. The theory for surface aeration is described 
under  Surface Aeration, page 63.  

 

 

17.4 Membrane Aeration 

17.4.1 Required Oxygen Uptake 

With the peak oxygen uptake OUh the required oxygen transfer αOC is calculated. Basis is a 
algorithm of Wagner /1/. 

Intermittent denitrification: 
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All other denitrification processes: 
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Oxygen solubility with Lutz Härtel /12/: 
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The water pressure is considered for the pressure aeration with fD: 

 

 35,10/*5,01 Dd hf +=  

 

The standard value for the construction hight is 0,3 m. This value can be adapted in Options 

> Menu to the given situation or product.  

 

 3,0−= WD hh  

 

International: German:  

req.αOC Oxygen transfer of an aeration facility in 

activated sludge with Cx, T, p 

erf.αOC O2-Zufuhr einer Belüftungseinrichtung in 

belebtem Schlamm bei Cx, T, p 

kg/h 

fd Factor for the effect of pressure on oxygen 

saturation concentration 

fd Faktor für Einfluss des Wasserüberdruckes 

auf die O2-Sättigungskonzentration 

- 

CS Dissolved oxygen saturation concentration 

dependent on the temperature and partial 

pressure 

CS Sauerstoff-Sättigungskonzentration, ab-

hängig von der Temperatur und dem 

Partialdruck 

mg/l 

CS,T Dissolved oxygen saturation concentration 

dependent on temperature and standard 

pressure 

CS,T Sauerstoff-Sättigungskonzentration, ab-

hängig von der Temperatur und dem 

Standard-Druck 

mg/l 

CX Dissolved oxygen concentration in aeration 

tanks (DO) 

CX Sauerstoffkonzentration im Belebungsbe-

cken 

mg/l 

Θ=1,024 Temperature correction  Θ=1,024 Temperaturkorrektur Belüftungskoeffizient - 

T Temperature T Temperatur °C 

OUh Oxygen uptake rate (hourly) OVh Stündlicher Sauerstoffverbrauch kg/h 

VAT Volume of the aeration tank VBB Volumen des Belebungsbeckens m³ 

VD Volume of the biological reactor used for 

denitrification 

VD Für Denitrifikation genutztes Volumen des 

Belebungsbeckens 

m³ 

hD Immersion depth of air hD Einblastiefe m 

hW Water level hW Höhe des Wasserspiegels m 

 

For the further design of the aeration system the maximum oxygen supply reqαOC resulting 
from the load cases is valid. reqαOC is the oxygen supply of an aeration system in activated 
sludge under operation conditions. 

The aeration system usually will be tendered for the verification of the oxygen supply OC 
under pure water conditions. The relation between activated sludge and pure water condi-
tions is the α-factor.  
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International: German:  
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OC Oxygen transfer of an aeration facility 

in clean water  with Cx=0, T=20°C, 

p=1013hPa 

OC O2-Zufuhr einer Belüftungseinrichtung in Reinwas-

ser bei Cx=0, T=20°C, p=1013hPa 

kg/h 

αOC Oxygen transfer of an aeration facility 

in activated sludge with Cx=0, 

T=20°C, p=1013hPa 

αOC O2-Zufuhr einer Belüftungseinrichtung in belebtem 

Schlamm bei Cx=0, T=20°C, p=1013hPa 

kg/h 

req.αOC Oxygen transfer of an aeration facility 

in activated sludge with Cx, T, p 

erf.αOC O2-Zufuhr einer Belüftungseinrichtung in belebtem 

Schlamm bei Cx, T, p (Betriebsbedingungen) 

kg/h 

α Quotient of oxygen transfer in acti-

vated sludge and in clean water 

α Verhältnis von Sauerstoffzufuhr in belebtem 

Schlamm und in Reinwasser 

- 

 

The α -factor is < 1 and that means OC > αOC. 

The higher value has to be verified by the suppliers of the aeration equipment. 

 

Oxygen Supply Factor 

Below you will find some experienced factors for different flow and mixing conditions, geome-
try and sludge conditions. 

 

Mixing Conditions Sludge Age 
d 

Air Volume 
m³/(m³*h) 

α -Factor 

Plug Flow 30 0,67 0,84 

Plug Flow 25 0,37 0,80-0,87 

mixed 8-15 0,16 – 1,43 0,36-0,66 

Table 3: α –values in activated chambers with divided mixing and aeration (Table 13/ 

Sludge Age 
d 

α -Factor 

3 0,3 

10 0,37 

25 0,82 

30 0,83 

Table 4: α –values depending on the sludge age (/3/: picture 13) 

 

 Belt Aeration 
System 

Extensive  
Arrangment 

Plate Diffusers Divided Mix-
ing / Aeration 

Number of 
values 

 4 4 2 

Average 
value 

0,64 0,62 0,69 0,85 

Table 5: α –value for membrane aeration systems ( /3/: table 4.1) 
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Required Air Volume 

Standard Conditions 

The required hourly air volume QL,D will be calculated as follows: 
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Required QL,D is the required hourly air volume under standard conditions: 

 KT 15,2730 =  

 mbarp 25,10130 =  

Operating Conditions 

The required hourly air volume reqQL under operation conditions results with the international 
formula for the geodetic height and the ideal gas equation as follows: 

 

Adaption to the operation pressure 

International geodetic height formula (T = 288,15 K, pN = 1013,25 mbar, Temperature Gra-
dient 0,65 K/100m, valid up to 11 km height) 
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Adaption to the suction temperature: ideal gas equation 
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International: German:  

h Geo height NN h Höhe über NN m 

hD Immersion depth of air hD Einblastiefe m 

p Operating pressure p Betriebsdruck mbar 

p0 Standard pressure 

(=1013,25 mbar) 

p0 Normdruck (=1013,25 mbar) mbar 

QL Air volume flow per hour QL Stündliche Luftmenge m³/h 

QL,0 Air volume flow per hour, 

standard conditions 

QL,0 Stündliche Luftmenge unter 

Normbedingungen 

m³/h 

SOTR=OC Standard oxygen transfer 

rate 

SOTR=OC Erforderliche Sauerstoffzufuhr 

unter Standardbedingungen 

kgO2/h 

SSOTE Specific standard oxygen 

transfer efficiency 

SSOTE Spezifische Sauerstoffzufuhr 

unter Standard-Bedingungen 

gO2/(m³*m) 

SSOTE% Specific oxygen transfer 

capacity 

SSOTE% Spezifische Sauerstoffausnut-

zung 

%/m 

T Operating tempertur T Betriebstempertur, hier: An- K 
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(suction side) saugtemperatur 

T0 Standard temperature 

(=273,15 K) 

T0 Standard Temperatur (=273,15 

K) 

K 

Φ Relative humidity φ Relative Feuchte % 

 

 

For the pressure air technology commonly a suction temperature of T = 293,15 K is used. 

This temperature is the basis for the parameters in catalogues of suppliers. 

 

 

Daily Air Volume 

The required daily air volume results from the mulitiplication with the aeration time. 

17.4.2 Blower 

The blower will be selected by the required air volume QL and the required counter pressure. 

The required air volume will be adapted to the operation conditions (T,P). With the interna-
tional height formula also the geodetic height is taken into account. The air demand increas-
es with the geodetic height. 

If a number of blowers are chosen, the capacities will be added to the total air supply QL. 

The counter pressure is the sum of pipeline losses, aerator losses and the immersion height. 
The pipeline losses are available under Options > Generel Constants. The aerator losses 
will be provided in the data banks. 

 

Evaluation of the operation point 

In the data bank for every blower type the motor power is listed depending on the required 
counter pressure. 

This means, one blower is listed several times with different pairs of counter pressure and 
motor power. 

All points between will be interpolated. 

17.4.3 Aerator 

Number 

The aerator elements will be dimensioned for the standard conditions. That means, the total 
air volume of the blowers has to be converted again to standard conditions. 

 ³][
*

**

0

0
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TpQL
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The number of aerator elements respectively the aerator length results as follows: 
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International: German:  

bA Load of the aerators bA Belüfterbeaufschlagung Nm³/(m*h) 

oder 

Nm³/(Stück*h) 

n Number of aerotors n Anzahl Belüftersegmente - 

QL Air volume flow per hour QL stündliche Luftmenge m³/h 

QL, Capacity of a blower QL, Tatsächliche Förderkapazität 

der gewählten Gebläse 

m³/h 

QL,0 Capacity of a aerator 

(standard conditions) 

QL,0 Förderkapazität der Belüf-

terelemente (Normbedingun-

gen) 

m³/h 

Floor coverage 

One important value for the oxygen input is the distribution of the aerators on the bottom of 
the chamber. 

The gasing area usually is listed in the data bank. If there is no value in the data set, the gas-
ing area will be calculated with a formula of Wagner /WAR 100, 1.38/. It is assumed that tube 
aerators gas out along the hole surface. 

On the side of the tubes there are unperforated strips. These strips has to close the tubes 
when the aeration is off. The width of the strips is about 30 mm. 

 
Fig. 57: Perforated area of a tube aerator  

 

Typical perforated area: 0,16 m² per m length of aerator 

 

 

 

17.5 Pipelines 
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17.5.1 Cross Section 

The aeration system usually contains a ramified pipeline system. This pipeline system con-
sists of various diameters. 

 

The air will be suctioned at environmental pressure and the temperature of the blower room. 
By the blowers the air will be compressed to the operation pressure in the pipeline system. 
Hereby the temperature will increase because of the compression. 

For the dimension of the pipe diameters the compression and the temperature increase are 
considered. 

It is assumed, that the heat of compression will totally affect the temperature increase of the 
gas (adiabatic compression).  

 

Then the formular of Poisson /13/, page 130 f is valid for the pressure relation. 

 

χχχ














=








=

−

CL

SL

S

C

S

C

Q

Q

T

T

p

p

,

,

)1/(

 

 

International: German:  

Index C Pressure site (compression) Index D Druckpage  

pS Pressure, suction site pA Druck, Ansaugpage mbar 

QL,S Capacity of a blower, suction site  

= QL,Blower 

QL,,A Luftmenge der gewählten Gebläse, 

Ansaugpage = QL,Gebläse 

m³/h 

TS Temperature, suction site TA Temperatur, Ansaugpage T 

κ = 1.4 Coeffizient for adiabatic compres-

sion 

κ =1,4 Adiabatenkoeffizient für 2-atomige 

Gase 

- 

With the equation above the temperature after compression TC and the compressed air vol-
ume QL,C can be evaluated. 

The required pipe diameter results from the air volume and the velocity. 
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International: German:  

Apipe Cross section of a pipe ARohr Rohrquerschnitt m² 

QL,C Capacity of a blower, pressure 

site 

QL,D Luftmenge, Druckpage m³/h 

VL Velocity of air vL Luftgeschwindigkeit im Rohr m/s 

 

The flow velocity is preset with 12 m/s. The velocity should be less than 16 m/s. With the 
velocity the pressure will increase. Also at high velocities a noticeable whistling can occure. 

17.5.2 Pressure Losses 

The pressure loss of the pipes is preselected with 100 mbar under Opions > General Con-

stants. 
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The pressure loss depends on a number of factors, for example: 

• Length of the pipeline system 

• Number of bows 

• Material of the pipe 

• Velocity in the pipes 

 

With short pipelines and low velocities the value for the pressure loss can be decreased. If 
there are no experienced values, the losses should be calculated. 

 

17.6 Surface Aeration 

Please notice:  

The surface aeration is not yet part of AQUA AERO. The theoretical basis is already 

included in the documentation to show the differences between the aeration systems. 

17.6.1 Oxygen Supply 

With the peak oxygen uptake OUh the required oxygen supply αOC of the aeration system 
will be evaluated. As for the pressure aeration also here the algorythm of Wagner /1/ is used. 

Intermittent Denitrification: 
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All elimination processes: 
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The first part of the equation contains a model for the respiration of the bacteria (OUh), the 
second part handles the diffusion of oxygen from the gas bubble to the liquid phase. 

With Lutz Härtel /12/ the oxygen saturation concentration cs at temperature T will be evalu-
ated as follows: 

 
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fd takes the influence of the water pressure in consideration. For surface aeration is valid: 

 35,10/07,01 Wd hf +=  

 

International: German:  

CS Dissolved oxygen saturation concentration 

dependent on the temperature and partial 

CS Sauerstoff-Sättigungskonzentration, 

abhängig von der Temperatur und dem 

mg/l 
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pressure Partialdruck 

CS,T Dissolved oxygen saturation concentration 

dependent on temperature and standard 

pressure 

CS,T Sauerstoff-Sättigungskonzentration, 

abhängig von der Temperatur und dem 

Standard-Druck 

mg/l 

CX Dissolved oxygen concentration in aeration 

tanks (DO) 

CX Sauerstoffkonzentration im Belebungs-

becken 

mg/l 

fd Factor for the effect of pressure on oxygen 

saturation concentration 

fd Faktor für Einfluss des Wasserüberdru-

ckes auf die O2-Sättigungskonzentration 

- 

hW Water level hw Höhe des Wasserspiegels m 

OUh Oxygen uptake rate (hourly) OVh Stündlicher Sauerstoffverbrauch kg/h 

req.αOC Oxygen transfer of an aeration facility in 

activated sludge with Cx, T, p 

erf.αOC O2-Zufuhr einer Belüftungseinrichtung in 

belebtem Schlamm bei Cx, T, p 

kg/h 

T Temperature T Temperatur °C 

VAT Volume of the aeration tank VBB Volumen des Belebungsbeckens m³ 

VD Volume of the biological reactor used for 

denitrification 

VD Für Denitrifikation genutztes Volumen 

des Belebungsbeckens 

m³ 

Θ=1,024 Temperature correction  Θ=1,024 Temperaturkorrektur Belüftungskoeffi-

zient 

- 

17.6.2 Power of the Aeration 

The total power N for the oxygen transfer is as follows: 

 ][kW
SAE

SOTR
N =  

 

The specific oxygen transfer is calculated: 

 

 
)35,2(2 bis

umdB vDhkSSOTR ∗∗∗=  

Exponent 2,5, valid for horizontal axes surface aerator 

3,0, valid for vertical axes surface aerator 

 

Typical values of oxygen transfer rates for different types of surface aerators: 

 Transfer rate kgO2/kW/h 

Aerator Type 

Standard/ 
pure water 

20°C, 0 mg/l 

Operation/ 
waste water 
15°C, 2 mg/l 

Slow rotation vertical axis 1,2 - 3,0 0,7 - 1,5 

Fast rotation vertical axis 1,2 - 2,2 0,7 - 1,2 

Horizontal axis 0,9 - 2,2 0,5 - 1,1 

Table 6: From /8/, page 572 

 

Typical chamber dimensions for surface aerators: 

Power Depth Width 

kW m m 
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7,0 3,0  -  3,7 9,1  -  12,2 

15,0 3,7  -  4,3 10,7  -  15,2 

22,0 4,0  -  4,6 12,2  -  1,3 

30,0 3,7  -  5,2 13,7  -  19,8 

37,0 4,6  -  5,5 13,7  -  22,9 

56,0 4,6  -  6,1 15,2  -  25,9 

75,0 4,6  -  6,1 18,3  -  27,4 

Table 7: From /8/, page 574 

Mixing 

The required power input depends on the chamber volume and the shape. 

 

Rectangular, Circular Chambers: 

Volume 500 m³ 1000 m³ 2000 m³ 

Specific energy input W/m³ 20 15 10 

Table 8: Source /9/, 10 - 23 

 

 

Oxidation Ditch, Ring Chamber 

For oxidation ditch and ring chamber a specific energy input of 10 W/m³ is recommended. 

Separate Mixing 

For mixing by separate mixers a value of 1- 5 W/m³ is recommended /4/. 

 

 

17.7 Oxygen Efficiency 

The oxygen efficiency SAE is the parameter for the economic of the aeration system. It will 
be evaluated, how much energy is required to supply the oxygen into the water. 

As first step the power consumption of the blowers and mixers will be evaluated. Then the 
real oxygen input into the activated chamber is calculated. 

Blower 

The power consumption of the blowers at the operation point has been evaluated with the 
values of the data bank. Here the losses because of motor efficiency, mechanical and fre-
quency converter efficiency must be considered.  

 

 ][
%)1(*%)1(*

kW
VFUVmechPK

PAGebläse
η

++
=  
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Mixer 

The real power consumption of the mixers cannot be calculated in AQUA AERO. Herefore 
you need informations of the suppliers. Therefore this value should be requested from the 
mixer suppliers. 

Power Consumption 

The total power consumption is the sum of the values from blower and mixer: 

][kWPAPAPA RührwerkGebläse +=  

Standard Oxygen Transfer Rate  

The chosen blowers are larger than the blowers required from the design. The standard oxy-
gen transfer rate SOTR, resulting out of the real air volume flow has to be re evaluated.  

 

 





=

h

kgOhSSOTEQ
SOTR DL 2

1000

**
 

 

Oxygen Efficiency 

For the calculation of the oxygen efficiency SAE the oxygen input will be set in relation to the 
power consumption of the machines. 

Oxygen efficiency related to the blowers: 

 





=

kWh

kgO

PA

SOTR
SAE

Gebläse

Gebläse
2  

 

Oxygen efficiency related to blowers and mixers: 

 





=

kWh

kgO

PA

SOTR
SAE 2  

 

International: German:  

hD Immersion depth of air hD Einblastiefe m 

PA Power input PA Leistungsaufnahme kW 

PK Coupling power PK Kupplungsleistung kW 

QL Air volume flow per hour QL Stündliche Luftmenge m³/h 

SAE Oxygen efficiency SAE=OP Sauerstoffertragswert kgO2/kWh 

SOTR=OC Standard oxygen transfer 

rate 

SOTR=OC Erforderliche Sauerstoffzufuhr  kgO2/h 

SSOTE Specific standard oxygen 

transfer efficiency 

SSOTE Spezifische Sauerstoffzufuhr 

unter Standard-Bedingungen 

gO2/(m³*m) 

 

The following table shows guide values for the oxygen efficiency for different membrane aer-
ation systems. 
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Capacity table of aeration systems 
 Favorable Average 
 SSOTE % 

%/m 
SAE 

kg/kWh 
SSOTE% 

%/m 
SAE 

kg/kWh 

Pure water conditions 
Extensively arranged aera-
tors 

8,0 4,5 6,0 3,4 

Extensively arranged plates 10,6 5,5 8,0 4,1 
Mixing and aeration 6,7 4,2 5,0 3,2 

Operation conditions 
Extensively arranged aera-
tors 

4,8 2,7 3,6 2,0 

Extensively arranged plates 6,4 3,2 4,8 2,5 
Mixing and aeration 4,1 2,5 3,1 2,0 

Table 9: Table 2 /1/ Modified table of reference values for membrane aeration systems 

17.8 Economical Calculations 

17.8.1 Basic Data 

Two compare different aeration systems all costs over the life time of the system have to be 
considered. These are Invest-, Reinvest- and Operating Costs.  

Costs, before the reference date have to be added up on interest. Costs which incure later 
have to be discounted. Costs at the reference date are the current worth, the sum is the pro-

ject life cycle cost. 

 

Value Description 

Life Time Time of use of machines, buildings ... 
If the life time is shorter than the project life time, a 
reinvest is required. 

Project Life Time Estimated time of use for the whole system. For the 
aeration system a life time of 25 years is ok.. 

Reference Date Beginning of the first year of operation. 

Interest Rate Long term interest rate for water and wastewater sup-
ply works, recommended 3,00 % p.a. /5/ 

Project Life Cycle 
Costs 

Sum of the current worths of a project at the reference 
date. 

 

Basis for the economical calculations is the KVR-Guideline/5/. The model 4.4.4 „Conversion 
of progressiv increasing cost lines“ is used. 

17.8.2 Investment Costs 

The invest costs are assumed as a single payment at the reference date. This is permissibly 
for a limited project like the aeration systems and because this invest is usually done a short 
time before starting the operation.  
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17.8.3 Reinvest Costs 

There are some parts of the equipment, which has to be replaced during the life time. These 
components will be reinvested and have to be considered in the total costs. They will each 
be discounted to the reference date. 

Discount factor DFAKE for single payments: 

 ( )
( )n

i
niDFAKE

+
=

1

1
;  

The cash value IK(0) results out of the multiplication of the nominal reinvest costs with the 
discount factor. 

 DFAKE * IK(n)  IK(0) =  

 

International: German:  

DFAKE Discount factor for a single pay-

ment 

DFAKE Diskontierungsfaktor für einmalige 

Zahlungen 

- 

i Interest rate (absolute), for exam-

ple 3% = 0,03 

i Zinssatz (absolut), z.B. 3% = 0,03 - 

IK(0) Current worth of investment at the 

reference date „0“ 

IK(0) Barwert der Investitionskosten zum 

Zeitpunkt „0“ 

€ 

IK(n) Investment costs at the date n IK(n) Investitionskosten zum Zeitpunkt n € 

n Project life time in years n Beobachtungszeitraum in Jahren - 

 

 

Ecample 

Evaluation time n = 25 Jahre, Interest rate i = 3% 

Average life time of a pump = 10 years 

During the evaluation time or project life time the pump has two be replaced for two times, in 

the year n1 = 10 and n2 = 20. The cost of the pump is IK(n) = 20.000,- €. 

The reinvest costs (IK) of the pumpe will be calculated back to the zero point. 

IK (0) = IK (n) * (DFAKE (3%;10) + DFAKE (3%;20)) 

           = 20.000 € * (0,74409 + 0,55368)  = 25.944,40 € 

17.8.4 Operating Costs 

General 

The conversion of operating costs to the current worth is a little bit more complicated, be-
cause it is a cost row with a yearly increase rate. 

The model for the discount factor of a numerical series with progressive increase is as fol-
lows: 

 ( )
( ) ( )

( ) ( )rii

ri
r

n

nn

−+

+−+
+=

1

11
1n)i,(r, DFAKRP   

 DFAKRP *BK   BK(0) =  
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International: German:  

BK Operational costs  BK Betriebskosten (bekannt) € 

BK(0) Current worth of the operational costs, incl. 

cost increase  

BK(0) Barwert der Betriebskosten inkl. Preis-

steigerung 

€ 

DFAKRP Discount factor for a numerical series with 

progressive increase 

DFAKRP Diskontierungsfaktor für eine Zahlungs-

reihe mit Progressiver Steigerung 

- 

i Interest rate (absolute), for example 3% = 

0,03 

i Zinssatz (absolut), z.B. 3% = 0,03 - 

n Project life time in years n Beobachtungszeitraum in Jahren a 

r Yearly rate of increase r Jährliche Preissteigerungsrate - 

 For  i = r is DFAKRP = n. 

 

The operating costs are divided into energy costs and other operating costs. For both parts 
different increasing rates can be chosen.  

Please note, that the substitution of equipment will be handled at the reinvest costs. 

It is assumed that the stuff costs, repectively the time amount is comparable for the different 
aeration concepts. Therefore they are not concluded in the operating costs. 

 

Energy Costs 

At the membrane aeration the energy cost mainly consist of the energy consumption of 
blowers and mixers. Both energy amounts will be evaluated differently.  

Blower 

The operation of the blowers depends on the oxygen demand respectively the load of the 
WWTP. The blowers therefore will be operated very variable. An evaluation of the energy 
consumption by the operating time is not adequate.  

 

Here the oxygen efficiency is used to adapt the energy consumption directly to the oxygen 
demand.  

 

 [ ]hkWh
SAE

mSOTR

Blower

/
*

 PAm =  

 [ ]d
Load

TarifNT
Load

TarifHTtLK /€
100

%100
*

100

%
***PA B middle Blower,Blower 







 −
+=  

International: German:  

BK Energy cost blower BK Energiekosten Gebläse € 

Load% Load high tarif time Fracht% Fracht in der HT-Zeit % 

m Factor  m Faktor zur mittlere Sauerstoff-

last 

- 

PA Power input PA Leistungsaufnahme kW 

SAE Oxygen efficiency SAE=OP Sauerstoffertragswert kgO2/kWh 

SOTR Standard oxygen transfer rate SOTR Mittlere Sauerstoffzufuhr  kgO2/h 
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Tarif Energy price (high, low) Tarif Energiepreis HT- bzw NT-Zeit €/kWh 

tL Operation time of the blowers tL Belüftungszeit h/d 

 

For the design of the aeration system peak loads are considered. For the operating costs we 
need the average oxygen demand. By evaluating the relation between peak and average 
load the average load is about 13 % lower than the peak load. For the calculation of the op-
erating costs the average oxygen demand is presetted by 0,86. 

The aeration time is – with the exception of intermittent denitrification – 24h. 

 

Mixer 

The energy demand of the mixers will be calculated by the operation time and the power 
consumption. For suitable chamber shapes it could be economical to stop the mixers during 
the aeration phase. The operation time for these aggregates will then only be considered for 
the unaerated time. 

If suppliers data are available, they should be entered at the form oxygen efficiency. Then 
they will be automatically considered at the operating costs. 

 

The energy demand W of the mixers is the sum of a part in the aerated and the anaerated 
period. Also operational costs are separately calculated for high and low tarif times. 

 

 [ ]dkWhtLdhPAdhW PhaseunbelMixer /)/24(*/24*PA .bel.Phase −+=  

 [ ]dTarifNT
tNT

TarifHT
tNT

WBK MixerMixer /€*
24

*
24

24
* 








+

−
=  

 

International: German:  

BK Energy cost mixer BK Energiekosten Rührwerk € 

PA Power input (aerated / non aerated) PA Leistungsaufnahme (belüftete / 

nur unbelüftete Phase) 

kW 

Tarif Energy price (high, low) Tarif Energiepreis HT- bzw NT-Zeit €/kWh 

tL Operation time of the blowers tL Belüftungszeit h/d 

tNT Low tarif time tNT NT-Zeit % 

WMixer Energy consumption of the mixer WRührwerk Energiebedarf der Mixer kWh/d 

 

If all mixers are operated continuously, the number of mixers in the aerated period is the 
same as the total number of mixers. 

If there is only one current tarif, NT = 0. 

Further Operating Costs 

The further operating costs include: 

• Consumables, which are necessary for maintenance of the equipment like fan belts or oil 
and 

• Maintenance, as a part of the invest costs from blower (incl. acoustic hood and standby 
blower) and mixer. 
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17.8.5 Project Life Cycle Costs  

The current worth of the project life cycle costs of an aeration system results from invest-, 
reinvest- and operating costs, converted to the reference date. The reference date is the start 
time of operation. Because here the reference date is the time of invest, the invest costs are 
current worths (year =0). Costs of reinvest and operating costs have to be discounted to the 
reference time. 

 
 (0)BK   (0)RIK   (0)IK    (0)PKBW ++=  

 

International: German:  

BK(0) Current worth of the operational costs BK(0) Barwert der Betriebskosten € 

IK(0) Current worth of investment at the refer-

ence date „0“ 

IK(0) Barwert der Investitionskosten zum 

Zeitpunkt „0“ 

€ 

PKBW(0) Current worth at reference time „0“ PKBW(0) Projektkostenbarwert zum Zeit-

punkt „0“ 

€ 

RIK(0) Current worth of the reinvest costs RIK(0) Barwert der Reinvestitionskosten € 
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18 Symbols 

German: International:  

ARohr Rohrquerschnitt Apipe Cross section of a pipe m² 

bA Belüfterbeaufschlagung bA Load of the aerators Nm³/(m*h) 

Nm³/(St.*h) 

Bd,BSB5 Tägliche BSB5-Fracht Bd,BOD Daily BOD5-load kg/d 

BK Betriebskosten  / Energiekosten BK Operational costs € 

BK(0) Barwert der Betriebskosten inkl. 

Preissteigerung 

BK(0) Current worth of the operational 

costs, incl. cost increase 

€ 

CBSB,ZB BSB5-Konzentration im Zulauf zum 

Belebungsbecken 

CBOD,IAT Concentration of BOD5 in the 

homogenised sample, Influent 

activated tank 

mg/l 

CP,NB,Z Phosphor Konzentration im Ablauf 

Nachklärung 

CP,EST Concentration of phosphorus, 

effluent sedimentation tank 

mg/l 

CP,BB,Z Phosphor Konzentration im Zulauf 

Belebungsbecken 

CP,IAT Concentration of phosphorus, 

inflow aeration tank 

mg/l 

CS Sauerstoff-

Sättigungskonzentration, abhängig 

von der Temperatur und dem 

Partialdruck 

CS Dissolved oxygen saturation 

concentration dependent on the 

temperature and partial pressure 

mg/l 

CS,T Sauerstoff-

Sättigungskonzentration, abhängig 

von der Temperatur und dem 

Standard-Druck 

CS,T Dissolved oxygen saturation 

concentration dependent on 

temperature and standard pres-

sure 

mg/l 

CX Sauerstoffkonzentration im Bele-

bungsbecken 

CX Dissolved oxygen concentration in 

aeration tanks (DO) 

mg/l 

DBB Äußerer lichter Durchmesser des 

Belebungsbeckens 

DAT Outer free diameter of the activat-

ed chamber 

m 

DBB,i Innendurchmesser beim Ringbe-

cken 

DAT,i Inner Diameter of a ring chamber m 

DFAKE Diskontierungsfaktor für einmalige 

Zahlungen 

DFAKE Discount factor for a single pay-

ment 

- 

DFAKRP Diskontierungsfaktor für eine Zah-

lungsreihe mit Progressiver Steige-

rung 

DFAKRP Discount factor for a numerical 

series with progressive increase 

- 

fC Stoßfaktor für die Kohlenstoffat-

mung 

fC Peak factor for carbon respiration - 

fd Faktor für Einfluss des Wasser-

überdruckes auf die O2-

Sättigungskonzentration 

fd Factor for the effect of pressure 

on oxygen saturation concentra-

tion 

- 

fN Stoßfaktor für die Ammoniumoxida-

tion 

fN Peak factor for ammonium respi-

ration 

- 

FT Temperaturfaktor für endogene 

Veratmung 

FT Temperature factor for endoge-

nous respiration 

- 

h Höhe über NN h Geo height NN m 

hD Einblastiefe hD Immersion depth of air m 

hw Höhe des Wasserspiegels hW Water level m 
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German: International:  

i Zinssatz (absolut), z.B. 3% = 0,03 i Interest rate (absolute), for exam-

ple 3% = 0,03 

- 

IK(0) Barwert der Investitionskosten zum 

Zeitpunkt „0“ 

IK(0) Current worth of investment at the 

reference date „0“ 

€ 

IK(n) Investitionskosten zum Zeitpunkt n IK(n) Investment costs at the date n € 

LBB Länge Belebungsbecken LAT Length of the aeration tank m 

Fracht% Fracht in der HT-Zeit Load% Load high tarif time % 

m Faktor zur mittlere Sauerstofflast m Factor - 

n Anzahl n Number - 

nBB Beckenanzahl nAT Number of tanks - 

OC O2-Zufuhr einer Belüftungseinrich-

tung in Reinwasser bei Cx=0, 

T=20°C, p=1013hPa 

OC Oxygen transfer of an aeration 

facility in clean water  with Cx=0, 

T=20°C, p=1013hPa 

kg/h 

OVd,C Täglicher Sauerstoffverbrauch für 

die C-Elimination 

OUd,C Daily oxygen uptake for carbon 

removal 

kg/d 

OVd,D Täglicher Sauerstoffverbrauch für 

die C-Elimination, der durch die 

Denitrifikation gedeckt wird 

OUd,D Daily oxygen uptake for carbon 

removal, which is covered by 

denitrification 

kg/d 

OVd,N Täglicher Sauerstoffverbrauch für 

Nitrifikation 

OUd,N Daily oxygen uptake for nitrifika-

tion 

kg/d 

OVh Stündlicher Sauerstoffverbrauch OUh Oxygen uptake rate (hourly) kg/h 

p Betriebsdruck p Operating pressure mbar 

P,BM Phosphat für Zellaufbau, bezogen 

auf den BSB5 

P,BM Phosphate for celle design, re-

ferred to BOD5 

kg P/kg 

BSB5 

p0 Normdruck (=1013,25 mbar) p0 Standard pressure (=1013,25 

mbar) 

mbar 

PA Leistungsaufnahme PA Power input kW 

Pbio,P Gesamtes Bio-Phosphat, bezogen 

auf den BSB5 

Pbio,P Total bio phosphate, referred to 

BOD5 

kg P/kg 

BSB5 

PK Kupplungsleistung PK Coupling power kW 

PKBW(0) Projektkostenbarwert zum Zeit-

punkt „0“ 

PKBW(0) Current worth at reference time 

„0“ 

€ 

pA Druck, Ansaugpage pS Pressure, suction site mbar 

Qd Täglicher Abwasserzufluss bei 

Trockenwetter 

Qd,DW Daily wastewater inflow with dry 

weather 

m³/d 

Qt,d Täglicher Trockenwetterzufluß Qd,DW Inflow at dry weather per day m³/d 

QL Stündliche Luftmenge QL Air volume flow per hour m³/h 

QL,0 Stündliche Luftmenge unter Norm-

bedingungen 

QL,0 Air volume flow per hour, standard 

conditions 

m³/h 

QL,0 Förderkapazität der Belüfterele-

mente (Normbedingungen) 

QL,0 Capacity of a aerator (standard 

conditions) 

m³/h 

QL,D Luftmenge, Druckpage QL,C Capacity of a blower, pressure 

site 

m³/h 

QL,,A Luftmenge der gewählten Gebläse, 

Ansaugpage = QL,Gebläse 

QL,S Capacity of a blower, suction site 

= QL,Blower 

m³/h 

r Jährliche Preissteigerungsrate r Yearly rate of increase - 

erf.αOC O2-Zufuhr einer Belüftungseinrich-

tung in belebtem Schlamm bei Cx, 

req.αOC Oxygen transfer of an aeration 

facility in activated sludge with Cx, 

kg/h 
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German: International:  

T, p T, p 

RIK(0) Barwert der Reinvestitionskosten RIK(0) Current worth of the reinvest costs € 

SAE=OP Sauerstoffertragswert SAE Oxygen efficiency kgO2/kWh 

SF Sicherheitsfaktor für Nitrifikation SF Safety factor for nitrification - 

SNH4,AN Ammonium Stickstoff, Ablauf 

Nachklärbecken 

SNH4,EST Concentration of ammonium 

nitrogen, effluent of sec. settling 

tank 

mg/l 

SNO3,D Zu denitrifierender Nitratstickstoff SNO3,D Concentration of nitrate nitrogen 

to be denitrified 

mg/l 

SNO3,denitrifizierbar Konzentration des denitrifizierbaren 

Nitratstickstoffs 

SNO3,denitrificable Concentration of denitrificable 

nitrate nitrogen 

mg/l 

SNO3,D,AN Nitratstickstoff, Ablauf Nachklärbe-

cken 

SNO3,EST Concentration of nitrate nitrogen, 

effluent of sec. settling tank 

mg/l 

SNO3,ZB Nitratstickstoff, Zulauf Belebungs-

becken 

SNO3,IAT Concentration of nitrate nitrogen, 

influent of activated tank 

mg/l 

SorgN,AN Nitratstickstoff, Ablauf Nachklärbe-

cken 

SorgN,EST Concentration of nitrate nitrogen, 

effluent of sec. settling tank 

mg/l 

SOTR=OC Erforderliche Sauerstoffzufuhr SOTR=OC Standard oxygen transfer rate kgO2/h 

ÜSd Tägliche Schlammproduktion SPd Daily waste activated sludge 

production (solids) 

kg/d 

ÜSd,P Tägliche Schlammproduktion aus 

der Phosphorelimination 

SPd,P Daily sludge production from 

phosphorus removal 

kg/d 

TSBB Trockensubstanzgehalt im Bele-

bungsbecken 

SSAT Mixed liqour suspended solids in 

the activated tank (MLSS) 

kg/m3 

SSOTE Spezifische Sauerstoffzufuhr unter 

Standard-Bedingungen 

SSOTE Specific standard oxygen transfer 

efficiency 

gO2/(m³*m) 

SSOTE% Spezifische Sauerstoffausnutzung SSOTE% Specific oxygen transfer capacity %/m 

T Temperatur T Temperature °C 

T0 Standard Temperatur (=273,15 K) T0 Standard temperature (=273,15 

K) 

K 

Tarif Energiepreis HT- bzw NT-Zeit Tarif Energy price (high, low) €/kWh 

tL Belüftungszeit tL Operation time of the blowers h/d 

tNT NT-Zeit tNT Low tarif time % 

TA Temperatur, Ansaugpage TS Temperature, suction site T 

tTS Schlammalter tSS Sludge age, cell residence time d 

tTS,aerob Aerobes Schlammalter tSS,aerob Aerobic sludge age d 

VBB Volumen des Belebungsbeckens VAT Volume of the aeration tank m³ 

VD Für Denitrifikation genutztes Volu-

men des Belebungsbeckens 

VD Volume of the biological reactor 

used for denitrification 

m³ 

vL Luftgeschwindigkeit im Rohr vL Velocity of air m/s 

WRührwerk Energiebedarf der Mixer WMixer Energy consumption of the mixer kWh/d 

XorgN,AN In die Biomasse eingebauter orga-

nischer Stickstoff 

XorgN,BM Concentration of organic nitrogen 

embedded in the biomass 

mg/l 

XP,Prec Bei der biologischen P-Elimination 

biologisch gebundener Phosphor 

XP,BioP Concentration of phosphorus 

removed with biological excess 

phosphorus removal process 

mg/l 

XP,Fäll Durch Fällung eliminierter Phos- XP,Prec Concentration of phosphorus mg/l 
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German: International:  

phor removed by simultaneous precipi-

tation 

XTS, ZB Trockensubstanzkonzentration im 

Zulauf zum Belebungsbecken 

XSS  Concentration of suspended 

solids of wastewater; Influent 

activated tank 

mg/l 

α Verhältnis von Sauerstoffzufuhr in 

belebtem Schlamm und in Rein-

wasser 

α Quotient of oxygen transfer in 

activated sludge and in clean 

water 

- 

αOC O2-Zufuhr einer Belüftungseinrich-

tung in belebtem Schlamm bei 

Cx=0, T=20°C, p=1013hPa 

αOC Oxygen transfer of an aeration 

facility in activated sludge with 

Cx=0, T=20°C, p=1013hPa 

kg/h 

Θ=1,024 Temperaturkorrektur Belüftungsko-

effizient 

Θ=1,024 Temperature correction - 

κ =1,4 Adiabatenkoeffizient für 2-atomige 

Gase 

κ = 1.4 Coeffizient for adiabatic compres-

sion 

- 

φ Relative Feuchte φ Relative humidity % 
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 Supplier information mixer 
Flygt, EMU, KSB  

 Supplier information blower 
Aerzener, Kaeser  

 Supplier information aerator 
OMS, OTT, Supraflex, Invent  

 Supplier information surface aerator 
Passavant-Intech, Landustrie, Fuchs, Biogest  
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Input Field  8 

Interest Rate, Def.  67 

Intermittend Denitrification  49 

Invest Costs  32, 67 

Kontakt  80 

Life Time, Def.  67 

Loads  17 
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Oxygen Efficiency  31, 66 

Oxygen Supply Factor  58 
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Oxygen Uptake  15, 53 

Peak  18, 55 

Theory  51 

Phosphate Elimination  14 

Biological  50 

Chemical  50 

Pipelines, Theory  62 

Power Consumption 

Mixer  66 

Project Life Cycle Costs  71 

Project Life Cycle Costs, Def.  67 
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Reference Date, Def.  67 
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21 Service 

 

BITControl 
is more than Hard- and Software 

 

 

 

Our range of services : 

• Software for planning of wastewater treatment plants:  AQUA DESIGNER 

• Software for economic design of aeration systems:  AQUA AERO 

• Process control and remote control technology for waste water,  
water treatment and biogas: AQUA BIO and PROVI 

• Online documentation systems: PROVI ONLINE 

• Online Backup: PROVI BACKUP 

•  Consulting services for mechanical and electrical engineering  

• Process studies of energy efficiency and  
optimization of wastewater treatment plants 

 

 

 

BITControl GmbH, Auf dem Sauerfeld 20, 54636 Nattenheim, Germany 

Telefon: +49 65 69 / 962 55-11 

Telefax: +49 65 69 / 962 55-19 

www.bitcontrol.info 

mail@bitcontrol.info 

 

 


